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H ello there, friend! Thank you for your purchase! You’re probably 
itching to get started on your new project. Just in case you bump into a 

roadblock, I’ve included this booklet of handy tips and tricks for Cricut and 
Silhouette users to help keep you moving forward.

Usage Info

Whether this is a free private use download or commercial use design, you 
can read the full Terms of Service by visiting:  https://kellylollardesigns.com/
terms-of-service

Please do not redistribute these files. If you know someone who would like a 
copy, send them a link so they can download this design also.

Join the Family

Part of the member library yet? If not, stop by the website and join the 
newsletter for access to the whole library of free commercial use cut files 
and personal use planner stickers. You’ll also receive e-mail exclusive 
designs and discounts as a bonus!

Have Questions?

I’m passionate about creating clean cut files and helping others. So if you 
have any questions or suggestions for additional pages, please don’t hesitate 
to contact me. 

Need one on one assistance or have feedback? I’m always happy to 
help! Email me at kelly@lollar.net or use the contact form at: https://
kellylollardesigns.com/pages/contact-me

Happy crafting!

About This Booklet

https://kellylollardesigns.com/terms-of-service
https://kellylollardesigns.com/terms-of-service
http://kellylollardesigns.com
mailto:kelly%40lollar.net?subject=
https://kellylollardesigns.com/pages/contact-me
https://kellylollardesigns.com/pages/contact-me
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Glossary

Carrier Sheet: A thin layer of plastic with 
adhesive used to transfer vinyl. Solid 
HTV usually includes one but printed 
HTV will require a separate sheet.

Compound Path: A set of shapes that 
are permanently connected and cut as 
one piece.

Cut Lines: Usually outlined in red or gray 
right before cutting, they show where 
the machine will actually be cutting.

Designer Edition: A paid software 
upgrade (license key) for Silhouette 
Studio that allows you to use SVG files. 

Force: A setting that controls the amount 
of pressure a cutting blade uses. Force is 
usually determined by the thickness of 
the material. 

Grouping: A set of shapes that are 
temporarily connected to easily select, 
move or manipulate.

HTV (Heat Transfer Vinyl): A vinyl used 
to create designs on fabrics or hard 
materials. It sticks when activated by a 
heat press or iron.

Inset (Internal Offset): Creates a larger 
line on the inside of a shape. Used to 
create an overlapping area to make 
pieces easier to line up.

Kiss Cut: When the machine only 
cuts the top layer, leaving the backing 
material untouched. When you peel a 
sticker from a sheet and the backing 
remains, it’s a Kiss Cut.

Knockout (KO): A hole left in a shape 
from removing another shape. When 
applied the base material will show 
through the knockout areas.

Mirror: To reverse or flip an image so it 
looks like it’s held up to a mirror. Needed 
for HTV cuts.

Offset: Expanding the size of a shape 
outward to create a matching border. 
Used to make lines thicker or to outline a 
shape.

Panels: The settings windows for 
functions in Silhouette Studio. Click 
Panels in the system menu to access the 
list.

Points or Nodes: A cut line is a dot to dot 
instruction for the machine. The points 
or nodes are the dots. They control the 
arch and angle of the lines.

Print Then Cut: Printing a raster file on 
printable vinyl or sticker paper followed 
by cutting the outlines with a machine.

Raster Files (JPG & PNG): Pixel based 
images used for printing. They are 
flattened and do not contain any 
information for cutting. Rasters will loose 
quality when increased in size.

Registration Marks: Marks used by a 
cutting machine to read where to cut a 
print.

Transfer Tape: Transparent contact 
paper like tape used to transfer adhesive 
vinyl.

Vector Files (SVG, DXF & EPS): 
Coordinate based files that contain 
information for creating shapes used 
for cutting. They are lossless or can be 
increased without loosing quality.

Weeding: Physically removing unwanted 
vinyl from a cut design after cutting.
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Downloading Your Files

From kld: The Checkout Page will have 
two download links. The top is from 
SendOwl, where I host bundles and 
larger downloads. The bottom is for 
Shopify which are the same files, just a 
backup location.

The Shopify link will auto download 
when clicked, while the SendOwl link 
will open a new page with an option 
to direct download or send to your 
Dropbox.

Tip: If the download does not start, 
check to see if you have pop-ups 
blocked or a content blocker enabled 
that may be stopping the download. 

In addition to your email receipt, you 
will also receive a separate Email from 
Shopify and/or SendOwl with the same 
links. You’ll receive an Update Email 
like these if any changes are made.

Your Account Page on the website will 
also have any SendOwl links with your 
purchase history.

For Etsy: Go to any page on Etsy. Click 
You in the upper right corner and 
Purchases and Reviews. A list of all 
of your purchases will come up with a 
Download Button to the right of any 
digital purchases. You can also use 
the search bar at the top to search for 
previous purchases.

Tip: The Etsy mobile apps do not have 
download links. If you are on mobile, 
log into Etsy using the browser on 
your phone or tablet. If you purchased 
a bundle from Etsy and would like 
to receive update emails or need 
assistance, please send a message or 
email me at kelly@lollar.net.

mailto:kelly%40lollar.net?subject=
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Downloading Dropbox Files

Click the download link from your 
order page, download sheet or 
message. You will be Redirected to 
Dropbox.

If you already have an account, you 
can log in and sync your new files to 
it or direct download everything.

Tip: The free account includes 2GB 
of storage you can access from 
the Dropbox app from any smart 
device. Super handy as an extra 
backup. 

If your page is set to Icon Mode, 
Click the List Icon to the upper right 
to change the view. (Not required, 
just makes it easier to select 
multiple items at once.) 

Download the Whole Folder as a 
Zip File by selecting a folder and 
clicking the Download button on the 
upper right on desktop. 

On mobile, click the ... to the right, 
directly under the folder name and 
select Download.

Download Unzipped Files by 
opening the folder for the file type 
you need. Click one file at a time 
to download individual, unzipped 
copies.

Click the Download Icon or the 
... to the right of the file name to 
download. 

Check your Download Folder or 
Dropbox to use your new files.
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Unzipping Your Download

Windows: Right click and Extract 
All. The folder should be added to 
the same location as the zip file. 
Most zip files go to the Downloads 
folder, but if you lose it, put the file 
name into the search bar to locate 
it.

Tip: If you are missing zip file 
software or  want a different option, 
I recommend 7-Zip. It’s free and 
has extra functionalities like Test 
Archive to check for file corruption.

Mac: Double click the zip file icon 
to unzip the folder in the same 
location. Most zip files go to the 
Downloads folder, but if you lose 
it, put the file name into the search 
bar to locate it.

iOS: Downloads automatically go to 
the Files app. Open the Files app 
and click the Zip Folder. The folder 
will automatically unpack and open. 

Android: Install Files by Google 
from the Play Store. Open Files by 
Google and find your downloaded 
zip file. Tap the zip file and click 
Extract at the bottom, then click 
Done. 

Tip: For more information check 
out this Lifewire article (https://
www.lifewire.com/unzip-files-on-
android-4178981) which is also the 
source for the image to the left.

https://www.7-zip.org
https://www.lifewire.com/unzip-files-on-android-4178981
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Troubleshooting Download Errors

Getting an error message when trying to open an svg? Assuming you’re not 
using Silhouette without the Designer Edition upgrade (if you are, skip to the 
DXF tutorial), try downloading your files again or from a different web browser.

Sometimes pop-up blockers or other filters can keep the download from 
working (this is usually the issue for SendOwl download errors). Another we 
see often, especially during the holidays on Etsy, is an interruption with the 
download server causing lost data. Usually trying again during a slower time of 
the day helps. 

For the errors from Design Space like the above, the file may have an extra 
element that was not formatted in it. Contact your seller to check the file. 

If you’re still having trouble downloading, especially around Christmas, please 
send me a message if you purchased from Etsy or an email to kelly@lollar.net 
with your order info for website purchases. I’ll email you a zip file and send 
over a Dropbox link.

Please note, Gmail sometimes blocks svg files for safety reasons, so Dropbox 
is the best solution for downloading unzipped files. Check the Dropbox how to 
for downloading or if you are on mobile, check the Unzipping Your Downloads 
page to learn how to unzip folders on mobile.
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Vinyl Cutter Alternatives

Printable Vinyl: You can use a 
printable vinyl from your local vinyl 
store or something like these from 
Expressions Vinyl.

Craft stores like Michaels usually carry 
the Silhouette printable vinyl. Plain 
Fabric is for cotton. Light Fabric is for 
white shirts and Dark Fabric for color 
shirts.

After printing your image, use scissors 
to cut around the design. If it starts 
fading after a few washes, press the 
vinyl again to brighten up the colors.

Outsource It: Check your local 
Facebook or NextDoor groups by 
posting for vinyl crafters or custom 
shirts. All they need is the svg file to 
either make the shirt for you or print a 
heat transfer.

You can also use the png file to order 
heat transfers from companies on Etsy 
just search for Custom Heat Transfers.

Screen Print It: If you’re making a large 
number of single color shirts, your 
local screen printer will usually be the 
most cost effective. This is the option I 
use for class shirts every year. 

You can also screen print at home 
using Speedball’s diy kit. Here’s a 
tutorial on the process. Once you go 
through the steps, you’ll see it’s pretty 
straight forward and you can’t beat 
the quality and feel of ink. I have shirts 
I screen printed almost a decade ago 
that still look great after hundreds of 
washes. 

https://expressionsvinyl.com/inkjet-printable-vinyl-sheets/
https://expressionsvinyl.com/inkjet-printable-vinyl-sheets/
https://www.silhouetteamerica.com/shop/heat-transfer
https://www.speedballart.com/our-product-lines/speedball-printmaking/speedball-screen-printing/speedball-screen-printing-kits/
http://www.theartofdoingstuff.com/how-to-screen-printsilkscreening-at-home/
http://www.theartofdoingstuff.com/how-to-screen-printsilkscreening-at-home/
https://www.speedballart.com/our-product-lines/speedball-printmaking/speedball-screen-printing/speedball-screen-printing-kits/
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Searching for Trademarks

Visit the Trademark Electronic Search 
System or TESS (http://tmsearch.
uspto.gov) .

Click Basic Word Mark Search (New 
User)

Select Plural and Singular on line 
one, Live on line two and type in your 
Search Term (word/words you are 
looking for). Set Field to Combined 
Word Mark (BI, TI, MP, TL), Result 
Must Contain to The Exact Search 
Phrase and click Submit Query.

You can narrow your search by adding 
a Classification. In the search bar, 
add “AND (###)[IC]” to the end of the 
search and hit enter to apply. 

Common Categories for Crafters: 
009 Popsockets, 14 Jewelry, 16 
Paper Goods, 18 Leather Goods, 21 
Housewares, 23 Yarns & Threads, 24 
Fabrics, 025 for Clothing, 26 Fancy 
Goods, 27 Floor Coverings, 28 Toys 
& Sporting Goods, 41 Education & 
Entertainment 

Click here to read the full list of 
Search Field Codes.

The oldest records on the last page are 
usually what you are looking for. Each 
page has 50 lines so skip ahead enter 
a number in the Start Line At (51, 101, 
151, etc.) and click Start. 

Look for Trademarks that are Live and 
have a Registration Mark. (Control-
click or Command-click to open in a 
new window.) Any Trademarks without 
a Registration Number have not been 
finalized, which means you can file a 
letter of opposition.

http://tmsearch.uspto.gov
http://tmsearch.uspto.gov
http://tmsearch.uspto.gov
http://tess2.uspto.gov/netahtml/tidm.html?_ga=2.243135042.1134597299.1585666756-1780214377.1566579471
http://tess2.uspto.gov/netahtml/tidm.html?_ga=2.243135042.1134597299.1585666756-1780214377.1566579471
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Searching for Trademarks Cont.

Next you’re looking for the Mark 
Drawing Code (Design Plus Words, 
Letters And/Or Numbers OR Words, 
Letters And/Of Numbers in a Stylized 
Form, etc.) The two you are looking 
for are Typed Drawing or Standard 
Character Mark. These are both 
defined as, “The Mark consists of 
standard characters without claim to 
any particular font style, size, or color.” 
Basically, the words themselves in any 
context.

The top example includes the image 
so it’s only valid with the artwork. The 
second example is what we’re looking 
for. You can see the list of exactly what 
the trademark applies to. Any items in 
brackets [ ] are expired and no longer 
covered by the trademark. In this 
case, if you were making a dress, skirt 
or jogging suit with the word Pirates, 
you’d be safe.

If you’d like to read the full application, 
click the blue TSDR Button at the 
top left. It will show you what other 
trademarks the holder has, the 
original filing paperwork , a list of legal 
prosecutions that have been filed to 
protect the trademark and more.

Tip: New trademarks are always being 
added, so make sure to check routinely 
or set a reminder to check again.

These records are only for federal 
trademarks, so you might need to 
check your state trademark database 
also to make sure you’re completely 
in the clear. Searching for your state 
name and Trademark Database will 
usually bring up the right link. 
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Importing SVG Files

Open Design Space and click New 
Project using the rectangle with a + sign 
or the button on the top right.

Click Upload (the cloud icon on the 
bottom of the left menu).

Click Upload Image on the left side of 
the screen. 

Drag and Drop your svg or Browse to 
locate it.

If the image looks right, make sure the 
file is named where you can search for it 
later. If not you can change the name or 
add tags. Click Save.

When you are ready to start your 
project, click the image to select it, then 
Click Insert Images in the lower right 
corner.

Tip: Hold Command or Control while 
clicking to add multiple images to the 
same project. 
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Centering and Aligning
Click Align in the top menu. You should 
get a drop-down that looks like this. 

Each option will line up everything you 
select with one edge of the images. 
For example, Align Left will make sure 
everything is as far left as it can get and 
lined up.

The Distribute functions will evenly 
space a group of objects if they are 
spaced apart. These work best if your 
elements are all the same size.

Align Left

Menu 

Align Top

Center Horizontally 

Center 

Center Vertically

Align Right

Align Bottom 
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Colors & Organizing

Welding: Keep pieces from moving 
when you cut by using the weld function. 

Hold Command / Control and click each 
layer you would like to stay in place (like 
the white in the eyes here).  

Click Weld in the lower right menu to 
make them one piece.

Recoloring: Change layer colors to 
get an idea of the final project, to cut 
everything on one mat or to prep 
for print then cuts using the fill color 
function. 

Hold Command / Control and click each 
layer you would like to be the same 
color.  

Click the Color Box to the right of the 
Linetype drop-down in the top menu. 
Choose one of the presets or Advanced 
to set your own color.

Cut on One Mat: Save time and vinyl by 
cutting everything on one mat.

Start by following the Recoloring 
directions to make everything one color. 
Click Make It.  

Click and Drag same colored items to 
different areas of the mat. To rotate, 
click and hold the circle arrow icon. The 
squares on the page correspond with your 
mat so you know where to place your 
colors. Try to leave a little extra space 
around each color for wiggle room.
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Curving, Rotating & Spacing Text

Curving: Type your words in the font 
and size you would like. If you have a 
template object like this circle, line the 
cross hatch up with the top, center of 
the shape. With the text selected, click 
Curve in the top menu. Use the slider 
to adjust the curve or you can manually 
enter a number for more control.

Rotating: Select your text box or object. 
click the Circle Arrow Icon or enter 
a degree in the Rotate Box in the top 
menu. Positive numbers (ex. 90˚) turn 
right and negative (ex. -90˚) turn left.

Spacing: In addition to changing the size 
of your letters, you can adjust the space 
between them.

Increase or decrease Letter Space for 
more or less space between each letter. 

Increase or decrease Line Space for 
more or less space between line of 
text. For some scripts you might need 
to go negative to remove blank space 
between lines. 

Manual Text Adjustment: Want 
something more precise?

With your text selected, click Advanced  
and Ungroup to Letters. Now you can 
move each letter independently or even 
rotate them for a playful setup. When 
you’re set, select all of your letters and 
Weld them to keep everything in place.

For more control over line spacing, simply 
type each line separately so they can each 
be moved around.
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Offset Shadow Text

Type your words in the font and size you 
would like. Move them to Position X 1.0 - 
Y1.0 or similar. 

Click Weld to keep the letters from 
moving when you cut.

Select your text layer and click Duplicate 
in the top right menu. Change the color 
of the new layer to make it easier to 
keep track. 

Move it to the same position as the 
original layer. Click Arrange and Move 
to Back.

With the bottom layer selected, Move 
the Text right and down with your arrow 
keys, mouse or the position settings.

Repeat the Previous Step using the 
bottom layer. Move it right and down 
the same amount as the second layer. 
Moving it further will give you a bigger 
offset.

Select the bottom two layers and click 
Slice.

Delete the first three pieces to be left 
with an offset that has gap knockout 
gap.

All done! Click Make It to cut.  

Tip: You can also do this with two layers 
for no gap.

If you would like both layers to be the 
same color, select both and Weld before 
cutting. 
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Knockouts

Formating Knockouts (KO): Opened an 
svg and all of the centers of the letters 
show up in pieces? 

Select all of the coorsponding layers  
and click Weld to make everything one 
piece.

Creating Knockouts V1: Place your 
knockout pieces over the solid piece 
you would like them in and select both 
layers. Click Attach in the lower right 
menu. This makes them one path, which 
means all of the lines showing on the 
cutting mat will cut, plus it can easily be 
undone by clicking Detach.

Creating Knockouts V2: Place your 
knockout pieces over the solid piece 
you would like them in and select both 
layers. Click Slice in the lower right 
menu. Delete the leftover pieces and 
you’re left with a permanent knockout.

Removing Knockouts V1: Use shapes 
like circles or rectangles to cover the 
areas you want removed. If you used 
multiple shapes, select them all with the 
original image and click Weld to make 
them all one piece permanently 

Removing Knockouts V2: Same as V1 
only click Attach if you need to be able 
to go back to the original.  

Removing Knockouts V3: Select your 
layer and click Contour in the lower 
right menu. To remove all of the 
knockouts click Hide All Contours or click 
one at a time to hide parts of the design.
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Breaking Compound Paths

Breaking Compound Paths V1: 

For a permanent solution, Duplicate 
your original layer and recolor it. 
(This one took four duplicates). Use 
Shapes to cover the parts you want 
to delete. 

Make sure to Weld the Shapes, 
then Slice them from the image. 
Delete your extra pieces and repeat 
until everything is separated. 

Now you can freely move them 
around.

Breaking Compound Paths V2: 

For a non-permanent solution, 
select your layer and click Contour 
in the bottom right menu. 

You can click the invidual shapes on 
the image or the boxes on the right 
to hide the cuts you would like to 
remove.

Once you’ve hidden all of the pieces 
you would like to remove, you’ll be 
left with just the selected parts.
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Adding Patterns to SVG Pieces

Open Design Space and click Upload as 
if you were uploading a new svg.

Click Upload Pattern on the right side of 
the screen. 

Drag and Drop your pattern or image 
and click Save.

Open an SVG and select the layer you 
want to add the pattern to. 

Set Fill to Print in the top menu.

Click the Color Window to the right of 
Fill and Select Pattern for the Print Type. 

Click the Pattern to apply it to the layer 
you selected before.

Tip: If you are applying a pattern to 
typed text or multiple pieces at once, 
make sure to select all of the letters and/
or pieces and click Weld in the lower 
right menu to make sure the pattern 
applies consistently across the image.

If you want to change the placement, 
size or direction of your pattern, click 
Edit Pattern at the bottom of the Color 
Window. 

Scale makes the pattern larger or 
smaller. Horizontal and Vertical move 
the pattern up/down or left/right. Rotate 
turns the pattern right with a positive 
number and left with a negative.

Tip: If your image is not a seemless 
pattern (all the edges match up), leave 
the scale at 100% or larger to prevent 
odd overlapping lines.
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Print Then Cut

Check your image for quality (300 dpi 
is optimal). Right click the image and 
select Properties or Details. You’ll see 
a pixel size or dpi (bigger is better and 
PNG or JPG work best).

Upload the image just like you would 
an svg file.

Choose your image type. If you’re not 
sure, stick with Complex and click 
Continue. 

Modify the image if needed by erasing 
parts or the background and click 
Continue. 

Save as Print Then Cut Image by 
clicking the color image to the left and 
Save.

Load your image from the Upload Tab. 
Resize the image, making sure the lock 
icon is on to keep your proportions. 
(My sticker sheets are usually 8” high.) 

Note: Max print size 6.25” wide by 
8.75” high.

Click Make It to go to the preview 
screen. If you get an error, go back 
a step and make sure your image is 
smaller than the max size.

Click Continue to print on vinyl, paper 
or sticker paper.

Place your print in the top left corner 
of your mat and load it in your 
machine.

Set your material and click Go. You’ve 
got yourself a cute new set of stickers!
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Print Then Cut Hack

Print Then Cuts printing out at a 
quarter of their actual size? Or maybe 
you just need a few copies cut of the 
same image. This hack is just thing for 
both situations.

I encountered a rare Design Space 
bug when I had a Windows 10 PC and 
Samsung color printer combo. No 
matter what I tried, my Print Then Cuts 
always came out at 25%.

Here’s the work around I found for 
this annoying bug. Load your Print 
Then Cut like usual. After resizing, click 
Make It, then Continue on the preview 
page.

After you click Send to Printer, change 
your selected printer to Microsoft 
Print to PDF. You’ll have a save 
window pop up. Save to Downloads or 
the folder you have your project in. 

Open the PDF and print it. It should 
print at the correct proportions.

Now Load your print in your machine 
and continue as usual by selecting 
your material and clicking Go. Crisis 
adverted!

Need to cut the same sheet a bunch of 
times? You can use this same hack. 

After you’ve cut your first sheet, load 
the next sheet and click Go again. As 
long as everything’s running on the 
same project you can cut it as many 
times as you need. Pretty neat!
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Importing SVG Files
Method 1: Open Studio and your Finder 
Window side by side. 

Locate the svg or dxf you would like to 
open in the finder window. 

Click the File Icon and Drag it onto the 
Studio window.

Tip: If you would like to open multiple 
files on the same project board, this is 
the best option. Drag as many as you 
need into the same window.

Method 2: Click File > Open or the File 
Folder Icon at the left of the top menu.

Use the finder window to locate the svg 
or dxf you would like to open. Select the 
File Icon and click Open.

This will open the file in a new window. 
For every file you open like this you’ll get 
a new window. 

Method 3: Click File > Library > Library 
or click the blue Library Tab at the left of 
the top menu.

Select the User Designs Folder. Open 
your Finder Window and locate the svg 
you would like to add. Click the File Icon 
and Drag it into the User Designs Folder. 
Double click the design to open it. 

Tip: This method is best if you want to 
open a design using a tablet or mobile 
device. The mobile app can only use 
designs from the Library.
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Preparing DXF Files for Cutting
Open Studio and open your DXF file just like you would a Studio file. 

Before moving anything, you need to complete a couple of quick steps:

Click Panels in the top menu and Select by Color:

Click a Color Box in the panel to select everything with that color, then right-click and 
Compound Path. Once each color is a compound path, you’re ready to cut! Super 
easy and more accurate than tracing.

Tips: Want to leave pieces out of a color group? Hold down shift and click the piece 
you are leaving out before creating the compound path.

You can also color in your pieces to make them easier to see by opening the Fill Color 
Panel, selecting a piece and clicking a fill color:

Visit the website for more tips like this, 
tons of freebies and more: 

https://kellylollardesigns.com

You can also reach me anytime at kelly@
lollar.net with questions.

Thank you so much for your purchase! 
Happy crafting!

https://kellylollardesigns.com
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SVG Default Program Settings

Let’s get rid of that pesky Internet 
Explorer icon for good and make 
opening SVG files easier!

Sure you can open Silhouette 
Studio and use the Library function 
to import an SVG or just drag and 
drop it into the program, but we’re 
so used to double clicking an icon 
and it just working. That and the 
IE icon on an SVG can be just plain 
confusing. So let’s take a second to 
fix it.

This process is the same for both 
Windows and Mac users, plus you 
can use it for any file type.

Locate an SVG File and Right Click 
it. Go down to Open With and select 
Other / Choose Another App.

Set the options to All Applications 
by using the drop down at the 
bottom of the window on Mac or 
clicking More Apps on PC.

Scroll down and Select the 
Silhouette Studio App. After it’s 
selected, check the Always Open 
With / Always Use This Application 
box then click Open / OK.

Your icon should change the Studio 
icon and now when you double click 
an SVG it will open with Silhouette 
Studio. Easy peasy!
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Troubleshooting Cut Errors
No Cut Lines: 

Double check that you have loaded the 
SVG Files. 

Make sure the pieces you are trying to 
cut have been selected. These should be 
automate in the latest version of Studio, 
but if you’re running an older version, 
select the pieces you are cutting. You 
should see red outlines around them on 
the Send screen.

Still not working? Check the 
Troubleshooting Downloads page.

Stray Line Across or Incomplete Cut: 

This usually happens on complicated 
designs with a lot of points. You can try 
selecting your design, click A for Edit 
Points and click the S icon in the top 
menu to Simplify.

Adjusting your Packet Size helps create 
smoother cuts also. Click Edit on PC or 
Menu on Mac > Preferences > Advanced 
> un-check Software Overcut > set 
Packet Size to 500 > click Apply

This should help all of your cuts. 

Loopy or Crazy Lines on DXF Files: 

Long story short, Studio adds points to 
designs when it renders them, especially 
DXF files. Some versions of the software 
have added so many they corrupt the 
file like this. 

Roll Back your Software a version or 
two following the instructions here.

Tip: You can also check the Silhouette 
School Blog to see what the current 
bugs are and the latest stable version of 
Studio.

https://kellylollardesigns.com/blogs/news/tutorial-silhouette-dxf-fix
https://www.silhouetteschoolblog.com
https://www.silhouetteschoolblog.com
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Centering and Aligning
Click Panels > Transform in the top menu or the 
Transform Icon (three vertical bars with a line 
through the middle). You should get a panel that 
looks like this. 

Each option will line up everything you select with 
one edge of the shapes. For example, Align Left 
will make sure everything is as far left as it can get 
and lined up.

The Spacing functions will evenly space a group 
of objects if they are spaced apart. These work 
best if your elements are all the same size.

Align Left

Align Top

Center Horizontally 

Center Center of Page 

Center Vertically

Align Right

Align Bottom 
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Colors & Organizing

Welding: Check to see if you have any 
overlapping pieces that are the same 
color, like script letters. Select all of the 
connecting pieces and right-click Weld to 
fuse them together.

Compound Paths: If you have a group 
of pieces that are the same color and 
want to make sure they keep the exact 
distance between them, select them all 
and right-click Compound Path.

Tip: You may need to send your newly 
connected pieces back if any others 
disappear.

Recoloring: Change layer colors to get 
an idea of the final project or to prep for 
print and cuts using the Fill Color Panel. 

Click Panel > Fill Color in the top menu 
or the Color Palette Icon.  With your 
piece selected, click a pre-existing 
color to swap. You can also click the 
Advanced Options arrow and type in a 
Hex Code. Or you can drag and drop a 
sample photo onto the board and use 
the Eyedropper tool to select a color 
from your sample.

Cut on One Mat: Save time and vinyl by 
cutting everything on one mat.

Click and Drag same colored items to 
different areas of the mat. To rotate, click 
and hold the green circle icon. 

The squares on the page correspond with 
your mat so you know where to place 
your colors. (The crosshatch here would 
be 1 over and 11 down on your mat.)

Tip: Try to leave a little extra space around 
each color for wiggle room just in case the 
cut shifts.
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Curving, Rotating & Spacing Text

Curving: Type your words in the font 
and size you would like. Use a template 
shape like this circle, to define the curve. 

Click and drag the Cross Hatch Circle at 
the left of the text box. If it disappears 
just click outside of the textbox and 
select it again.

Click and drag the Oval to the left to 
move your text up and down on the 
path. 

Tip: Try to center your text on the path 
for best results.

Rotating: To rotate your text while 
placing it on a path, drag the Cross 
Hatch Circle left and right.

If you just need a simple rotation, click 
and hold the Green Dot while turning.

You can also open the Transform Panel 
and click the circle arrow to rotate. 
Positive numbers (ex. 90˚) turn right and 
negative (ex. -90˚) turn left.

Manual Text Adjustment: Want 
something more precise?

With your text selected, right-click and 
Ungroup. Now you can move each letter 
independently or even rotate them for a 
playful setup. When you’re set, select all 
of your letters and Weld then Compound 
Path them to keep everything in place.

For more control over line spacing, simply 
type each line separately so they can each 
be moved around or use the Text Style 
Panel.
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Offsets & Shadow Text

Type your words in the font and size you 
would like. 

Right-click and Weld then Compound 
Path to fuse everything together. (When 
in doubt always repeat this step. It keeps 
you from having to select a ton of little 
pieces later.)

Select your text layer and open the 
Offset Panel or click the star in a star 
icon. Click Offset to increase the size 
or Internal Offset to decrease the size. 
Use the slider or enter a number to set 
the distance. Select sharp or rounded 
corners. 

Click Apply and change the color of 
the new layer to make it easier to 
keep track. Make sure to Weld and 
Compound Path again to fuse everything 
together.

For a Double Offset, select your first 
offset layer and repeat the process. 

From here you can use the modify 
panel to subtract the middle layer 
from the bottom to leave a blank space 
or knockout. Make sure to Weld and 
Compound Path after subtracting.

Want a Shadow Effect? Select and move 
your offset layers using your arrow keys 
or the X and Y coordinates in the top 
toolbar. 

Tip: Have a thin font you love but it’s a 
pain to cut? Try offsetting it by 0.025 to 
0.05” to thicken it up a little bit. Fonts 
always tend to look wider on screen 
than they do once they’re cut out.
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Knockouts & Modify Panel
Modify Panel: Click Panels > Modify or the 
intersecting rectangle and circle icon to open.

Here’s where you go to knockout shapes, weld 
pieces together, compound path and more. 

The best way to get a handle on what each 
function does is to make a couple of shapes 
and try each one out yourself. Here’s a quick 
summary of what each function is used for:

Weld: This fuses 
two or more 
shapes together 
permanently into 
one shape. 

Tip: Use this fuction 
for script fonts 
to attached your 
letters together.

Subtract: This 
deletes the front 
object from the 
back object, leaving 
you with one piece. 

Tip: Use this 
function to add 
knockouts to a 
shape.

Subtract All: This 
deletes the front 
object from to back 
object without 
deleting the original 
shape. This is now 
2 pieces, a square 
with a circle shaped 
hole and a circle.

Intersect: Like the 
divide function, 
this creates a 
new shape from 
the area where 
everything 
intersects. Unlike 
divid, this leaves 
you with only the 
intersection piece.

Divide: This creates 
a new shape 
from the area 
that everything 
intersects. This is 
now 3 separate 
pieces.

Crop: Like intersect 
for three or more 
shapes. Originally 
this was 2 circles 
and a square. All 
that is left is a 
piece created from 
any areas that 
overlapped. 
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Grouping, Welding & Compound Paths

Grouping: Grouping multiple pieces 
together makes it where you can 
select them all at once without being 
permanent. 

Imagine you had a pile of letters. 
Grouping would be like throwing 
them in to a box. They’re all still 
disconnected, just contained. 

Welding: Welding is when you take 
any touching or overlapping pieces 
and make them into one piece. In the 
sample text photo the second line is 
welded. Only overlapping parts are 
now permanently connected.

So if we go back to our pile of letters. 
Image we made sure the letters were 
touching for each word then welded 
the words. Now we have a piece for 
each word instead of a bunch of 
letters, so if we shake the box only the 
words are floating around.

Compound Path: Creating a 
compound path is a permanent way 
to group pieces. It tells your machine 
that all of these pieces must be cut 
together. If any of those pieces overlap 
and are not welded like the bottom 
row of text, the machine will still cut all 
of the lines. That’s why when you don’t 
weld script fonts, you get pieces from 
the previous letter cut out of the next 
one. In those cases you want to weld 
and then compound path.

Back to our pile of words, this would 
be like gluing all the words down to the 
box so nothing moves when we shake 
it.

When in doubt and you need pieces 
connected, weld and compound path.
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Breaking Compound Paths

Breaking Compound Paths V1: 

For a permanent solution, Duplicate 
your original layer and recolor it. 
(This one took four duplicates). Use 
Shapes to cover the parts you want 
to delete. 

Subtract the shapes from the 
original layer and repeat until 
everything is separated. 

Breaking Compound Paths V2: 

Right-click and Release Compound 
Path. Now every cut line in the 
shape is disconnected. We’ll have to 
fix the letters before moving on.

Select the base letter and it’s center 
then click Subtract. Do this for each 
letter. 

Or if you’re feeling ambitious, select 
the base pieces for all of the letters 
you’re connecting again (don’t 
forget to select the dots on i and j) 
and Compound Path them together. 
Right click the new shape and Send 
to Back to make sure it’s under the 
pieces you’ll be knocking out. 

Now select all of the pieces and 
Subtract the centers from the 
letters. While everything is still 
selected, Compound Path it all 
together again.

Tip: When you click on an object 
you’ll see a light outline box around 
it. Each box is a separate cut. If you 
see multiple boxes you know your 
object is not a compound path. 
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Adding Patterns to SVG Pieces

Open Studio and click File > Library or 
the Library Tab (upper right) as if you 
were uploading a new svg.

Click the Patterns Folder on the left 
side of the screen. Drag and Drop your 
pattern or image in the space to the 
right.

Go back to the Design Tab. Open an 
SVG and select the layer you want to add 
the pattern to. Hold shift while clicking 
to select multiple pieces.

Click Panels > Fill Color or the Palette 
Icon in the right side menu.

Click the Polka Dot Tab at the top of the 
panel and click the Pattern to apply it to 
the layer you selected before.

Tip: If you are applying a pattern to 
typed text or multiple pieces at once, 
make sure to right click and Weld 
connecting letters or right click and 
Compound Path pieces that are not 
touching to make sure the pattern 
applies consistently across the image.

If you want to change the placement, 
size or direction of your pattern, click 
Advanced Options at the bottom of the 
Fill Panel. 

Scale makes the pattern larger or 
smaller. Rotate turns the pattern. Pan 
Pattern gives you a arrow icon in the 
center of the piece you can drag to 
move the image around inside. 

Tip: If your image is not a seemless 
pattern (all the edges match up), leave 
the scale at 100% or larger to prevent 
odd overlapping lines.
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Print & Cut

Check your image for quality (300 dpi 
is optimal). Right click the image and 
select Properties or Details. You’ll see 
a pixel size or dpi (bigger is better and 
PNG or JPG work best).

Open Studio and set your Page Size to 
Letter (vertical). Upload the image or 
planner sticker svg just like you would 
an svg file.

Resize the image if needed, making 
sure the lock icon is on to keep your 
proportions. (My sticker sheets are 
usually 8” tall.) 

In the Page Setup Panel, click the 
Registration Mark tab (the last one). 
Select Default and set your dimensions 
as low as you can. Make sure your 
image is inside of the registration 
marks on the art board.

I usually include a black cut file under 
the print image for my Print & Cuts. If 
you only have a PNG, the latest version 
of the software should auto-detect the 
cut lines. You can also use the Trace 
Panel to create cut lines.

Set to Solid Fill, Trace Outer Edge and 
slowly increase the Threshold until 
your shapes are solid yellow. Now you 
have cut lines.

Select your trace or cut file and click 
Send. Set your material (I use Sticker 
Paper, White) and Action to Cut.

Tips: Machine having trouble reading 
your registration marks? Try placing a 
lamp close by to give it more light. If 
the cut marks are off, you may need to 
calibrate using Silhouette America’s 
directions here. 

https://www.silhouetteamerica.com/faq/solution/print-and-cut-registration-failure-or-cutting-off
https://www.silhouetteamerica.com/faq/solution/print-and-cut-registration-failure-or-cutting-off
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Installing & Using Inkscape

Start by visiting Inkscape’s homepage 
(https://inkscape.org/en/). 

Click on Download in the top menu and 
select Windows or Mac depending on 
what kind of computer you have.

Double Click the Downloaded File to 
install. There will be a pop-up with a list 
of options. Stick with the presets unless 
you need translations or to change the 
language. Click Next.

The second pop-up will ask where to 
keep the program on your hard drive. 
The preset Program Files is usually the 
best place and makes it easier to find 
later. Click Install.

A third pop-up will give you a progress 
bar for the extraction. Once it’s 
complete, click Finish and open the 
program. 

It should look something like this screen 
with a single artboard in the middle 
to start with. The artboard is where 
you should place any artwork you are 
exporting for the final product. 

Tip: Here is a quick list of handy 
shortcuts to get you started. To learn 
more about using Inkscape, check out 
these sources:

YouTube

Inkscape Tutorials

Downloadable Manual

https://inkscape.org/en
https://inkscape.org/en
https://www.youtube.com/results?search_query=inkscape+tutorials
https://inkscape.org/learn/
https://inkscape-manuals.readthedocs.io/en/latest/
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Recoloring Designs with Vectr

Start by visiting Vectr’s homepage at 
https://vectr.com or downloading the 
mobile app. (It’s free!)

After signing up for an account, click 
Create File and upload your svg file. 
Click the File Settings (paper with a gear 
icon on the top right) and name your 
project. If you’ll be resizing, you can set 
the measurements to inches here.

Select a piece to recolor then click the 
Color Box to the right. You can use the 
slider to change the color or enter a Hex 
Code.

If you’d like to use a reference photo for 
colors, drag and drop the photo onto 
the window. In the color menu, click 
the Eyedropper Icon and click on the 
reference photo to pick a color.

Make sure Border, Shadow and Inset 
Show are un-checked to the right. 

Select your design then click the Export 
Icon (rectangle with an up arrow). Set 
the first drop-down to Selection or if 
your design is the only thing on the page 
you can select Page. Select JPG in the 
second drop-down for a print image. 
(PNG will only export at 72 dpi with no 
color settings while the JPEG contains 
the color profile and has a much higher 
resolution better for printing.)

You can resize by changing the height or 
width. Even if the dimensions are set in 
pixels, you can use the inches symbol (“) 
to change the size in inches.

Right-click and Save the image or click 
the image and drag it to your download 
folder or desktop. You’re all recolored 
and ready for a printing!

https://vectr.com
https://vectr.com
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Modifying & Printing with Vectr
Start by visiting Vectr’s homepage at https://vectr.com or 
downloading the mobile app. (It’s free!) 

After signing up for an account, click Create File and drag and 
drop your svg into the window. To Drag and Drop click on the 
svg file for your image and while holding down the mouse 
button, drag it to the Vectr page then release.

Click the File 
Settings (paper with 
a gear icon on the 
top right) to name 
your project and set 
the measurements to 
inches here.

Group each part 
of the image by 
selecting a group and 
right-click Group

Add your Names 
using the Text 
function (the T icon 
on the left menu). 
Then resize and color 
your text as desired. 
Copy/Paste the first 
name to add more.

Make sure Border, 
Shadow and Inset 
Show are un-checked 
to the right.

https://vectr.com
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Modifying & Printing with Vectr

Select everything in the design using your mouse or the shortcut Cmd-A / Ctrl-A. 
Resize the full image to fit your paper size. 

Since most printers can’t print to the edge, make sure to reduce the size by about a 
1/4 inch.

If you need to Mirror your image to print on trasfer paper, select everything and click 
the Flip Horizontal button at the top of the image. 

Select your entire design then click the Export Icon (rectangle with an up arrow). Set 
the first drop-down to Selection. Select JPG in the second drop-down for a print image. 
(PNG will only export at 72 dpi with no color settings while the JPEG contains the color 
profile and has a much higher resolution better for printing.)

You can resize by changing the height or width. Even if the dimensions are set in pixels, 
you can use the inches symbol (“) to change the size in inches. 

Right-click and Save the image or click the image and drag it to your download folder 
or desktop. You’re all ready to print!



Hope you found some handy new 
tricks. For more in depth tutorials 
and freebies to try out your new 

skills, visit the website at 
https://kellylollardesigns.com

Thank you!

https://kellylollardesigns.com

